Preface

Users installing and operating the product is required to understand this manual and relative manuals fully before installation and operation.

All rights of the software and hardware described in the manual are protected by the patent law.
CONTENTS

1. OVERVIEW .................................................................................................................................6
  1.1 INTRODUCTION ........................................................................................................................6
  1.2 FEATURE ................................................................................................................................6

2. INSTALLATION ...........................................................................................................................6
  2.1 SYSTEM REQUIREMENT .............................................................................................................6
  2.2 INSTALLATION GUIDE ...............................................................................................................7

3. SYSTEM LOGIN ..........................................................................................................................8
  3.1 SITE REGISTRATION ..................................................................................................................8

4. INITIAL INSTRUCTION ...............................................................................................................8
  4.1 SITE REGISTRATION ..................................................................................................................8
  4.1.1 REGISTRATION ....................................................................................................................9
  4.2 SCREEN LAYOUT REGISTRATION ...........................................................................................10
  4.2.1 REGISTRATION .................................................................................................................. 10
  4.3 USER REGISTRATION ............................................................................................................. 13
  4.3.1 USER GROUP REGISTRATION ......................................................................................... 13
  4.3.2 USER REGISTRATION .......................................................................................................... 14

5. MENU ........................................................................................................................................ 16
  5.1 VIEW ....................................................................................................................................... 16
  5.2 SYSTEM ................................................................................................................................... 17
  5.2.1 LOG MANAGER .................................................................................................................. 17
  5.2.1.1 LOG VIEW ..................................................................................................................... 17
  5.2.2 APP SETUP ......................................................................................................................... 19
  5.3 SETUP .................................................................................................................................... 21
  5.3.1 EDIT PASSWORD .................................................................................................................. 21
  5.3.2 USER INFORMATION .......................................................................................................... 21

6. VIEWER ..................................................................................................................................... 22
  6.1 VIEWER OVERVIEW ................................................................................................................. 22
  6.2 IMAGE VIEW ............................................................................................................................. 22
  6.2.1 IMAGE VIEW BY CONNECTING SECURITY DEVICES ......................................................... 23
  6.2.2 IMAGE VIEW BY CONNECTING CAMERAS ....................................................................... 23
6.2.3 IMAGE VIEW THROUGH THE SECOND MONITOR ................................................................. 23
6.3 EVENT LIST .................................................................................................................................. 24
6.3.1 EVENT INFORMATION VIEW ......................................................................................................... 24
6.4 STATUS LIST ................................................................................................................................. 24
6.4.1 SECURITY DEVICE STATUS INFORMATION VIEW ................................................................ 24
6.5 POPUP IMAGE .................................................................................................................................. 24
6.5.1 THUMBNAIL IMAGE VIEW IN POPUP IMAGE WINDOW ......................................................... 25
6.6 BASIC CONTROL .................................................................................................................................. 25
6.6.1 PTZ CONTROL .................................................................................................................................. 25
6.6.2 RELAY OUT CONTROL ................................................................................................................. 27
6.6.3 TWO WAY AUDIO CONTROL ......................................................................................................... 27
6.6.4 COLOR ADJUSTMENT ...................................................................................................................... 27
6.6.5 SCREEN SEQUENCE FUNCTION .................................................................................................. 28
6.6.6 OTHER FUNCTIONS ....................................................................................................................... 28

7. NETWORK PLAYER ................................................................................................................................. 29
7.1 NETWORK PLAYER OVERVIEW ....................................................................................................... 29
7.1.1 PLAYBACK OF THE RECORDED IMAGE ..................................................................................... 30
7.2 SEARCH .................................................................................................................................................. 30
7.2.1 TIME SEARCH ................................................................................................................................. 31
7.2.2 PREVIEW SEARCH ............................................................................................................................ 31
7.3 PLAYBACK .............................................................................................................................................. 32
7.3.1 PLAYBACK OVERVIEW .................................................................................................................... 32
7.3.2 TIME LINE ........................................................................................................................................ 33
7.3.3 PLAYBACK CONTROL ....................................................................................................................... 33
7.3.4 CONTROL .......................................................................................................................................... 33
7.4 DOWNLOAD ........................................................................................................................................... 34
7.4.1 DOWNLOAD OF THE RECORDED DATA ....................................................................................... 34

8. FILE PLAYER .............................................................................................................................................. 35
8.1 FILE PLAYER OVERVIEW .................................................................................................................... 35
8.1.1 PLAYBACK OF THE RECORDED DATA ........................................................................................ 35
8.1.2 TIME LINE ....................................................................................................................................... 35
8.1.3 PLAYBACK CONTROL ...................................................................................................................... 36
8.1.4 CONTROL .......................................................................................................................................... 36
8.2 SMART SEARCH .................................................................................................................................... 36
8.2.1 SMART SEARCH .............................................................................................................................. 37
9. SECURITY DEVICE SETUP ADMINISTRATOR

9.1 SECURITY DEVICE SETUP ADMINISTRATOR OVERVIEW .......................................................... 38
9.2 START OF THE SECURITY DEVICE SETUP ........................................................................... 38
9.3 OPEN/SAVE SETUP VALUE ................................................................................................. 38
9.4 SETUP DATA RESET AND FACTORY DEFAULT RESET .................................................... 38
1. Overview

1.1 Introduction

This program is Central Management System that is designed to control various security devices (IP camera, DVR, NVR, Video Sever) connected from a single PC by networking. This program consists of the multi-functions including the live image monitoring, real-time event management, security device status monitoring, and then image search, playback, download, smart search and watermark etc.

1.2 Feature

In the program, users can register security devices without quantity limitation and it provides a real-time monitoring of max. 128 cameras as long as VGA card in PC supports two monitors. Users can control a function window size as each function has a separate window.

This program manages the user account and group. It provides a separate management of the user account by allowing the administrator to set the authority of detail features for the group.

This program manages and saves events that were sent from many security devices. This program reports users an alarm set with events through the pop-up message, audio and real-time image etc.

In the network player, users can search the recorded file and play and download the image and audio. A searching term by second is available and the preview screen enables users to search images without playing actual images.

The recorded file with images and audios in PC can be played by File Player and it provides a faster search of information by the smart search and water mark.

2. Installation

2.1 System Requirement

In order for proper operation of the program, it requires PC more than the min. specification. With the min. specification, it only provides min. functions. For full operation of the program, PC is
required to be equipped with more than the recommended specification.

<table>
<thead>
<tr>
<th>System</th>
<th>Min. Specification</th>
<th>Recommend Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel Core2Duo 2.0GHz</td>
<td>Intel Core2Quad 2.66GHz</td>
</tr>
<tr>
<td>Main Memory</td>
<td>2GB</td>
<td>4GB or higher</td>
</tr>
<tr>
<td>Video Card Memory</td>
<td>128MB</td>
<td>512MB or higher</td>
</tr>
<tr>
<td>Display Resolution</td>
<td>1024 * 768 (With 32bit color) or higher</td>
<td></td>
</tr>
<tr>
<td>HDD</td>
<td></td>
<td>80GB or higher</td>
</tr>
<tr>
<td>OS</td>
<td></td>
<td>Windows XP SP2 or higher</td>
</tr>
<tr>
<td>Others</td>
<td></td>
<td>Direct X 9.0 or higher</td>
</tr>
</tbody>
</table>

2.2 Installation Guide
1. Insert software CD into the CD drive of PC.

2. Click on Setup.exe. An install program will be executed and a language selection page will shows up.

3. Select a desired language.

4. Designate a folder in which the program is installed and click on “Next”, and then installation starts.
3. System Login
System Login is to decide a program execution/block by confirming the user name and password.

3.1 Site Registration

1. In the program start menu, go to Netus Standard Menu and select Netus Standard icon or double-click on Netus Standard icon in the wallpaper, and then the login window pops up.

2. Select one of the names of registered users in the login window. For the first time login, select Administrator. Administrator is registered as a fundamental user.

3. Enter a password. For the first time login, enter an administrator password. The administrator password “1111111”. After login, change the administrator password.

4. The program starts if the password is right.

Note

- To change the password, go to „Setup_ ->„Password Change_ menu. (For more information, refer to „5.2.9 Password Change_.
- In Netus Standard program, multi-user registration is available, all users can log in one PC with separate user information. Each user can configure a preferred program environment, and then the program starts according to each user’s setting after login.
- Information of the latest window environment will be saved when the program is closed.

4. Initial Instruction
4.1 Site Registration
Security devices need to be registered after login. With registered security devices, users can use functions including real-time monitoring, search and playback, backup and event alarm.
4.1.1 Registration

1. Select "Setup -> Site Manager" menu. Site Manager Setup window shows up.

2. In Site Manager, functions including site add, delete, modify, all select, all clear and properties are available.

3. Click on "Add" and enter a security device name, description, connect address and port.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the security device to be used in the program</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the security device</td>
</tr>
<tr>
<td>Connect Address</td>
<td>Network address of the security device</td>
</tr>
<tr>
<td>Port</td>
<td>Network port no. of the security device</td>
</tr>
<tr>
<td>Camera Count</td>
<td>The number of cameras connected to the security device</td>
</tr>
<tr>
<td>User Name</td>
<td>User name registered in the security device</td>
</tr>
<tr>
<td>Password</td>
<td>Password registered in the security device</td>
</tr>
</tbody>
</table>

4. In "Modify" users can modify the security device name, connect address and port.

5. In "Delete", users can delete selected sites.
6. Clicking on "All Select" makes all sites selected and "All Clear" makes all sites un-ticked.

---

**Note**

- Netus Standard program automatically starts a connection to ticked addresses in Site Manager after successful login.
- A connection doesn't happen for un-ticked security devices.
- There is no limit for registering sites in Netus Standard program.

---

### 4.2 Screen Layout Registration

Screen Layout enables users to collect and monitor desired real-time monitoring images from various security devices. Users can register desired cameras in a desired channel mode.

#### 4.2.1 Registration

1. Select "Setup_->_Screen Layout Manager_ menu. Screen Layout Manager window shows up.
2. Click on „Add“. In Screen Layout Setting window, select Channel Mode and drag cameras from the list at left and drop them onto desired locations, and then the real-monitoring image turns up. Screen Layout Name and Channel Mode must be filled for registration.

3. After finishing camera addition, users can check a newly registered screen layout in Screen Layout Manager. Users can modify and delete the screen layout as desired.
4. Users can move a list tab in Connect List to Layout and check a list of registered Screen Layout. Real-time monitoring images show up by using drag/drop onto the screen.
4.3 User Registration

User Registration is to register and manage ID of the program users. It decides the program to be executed or blocked by confirming ID and password and also gives different authority to each user group for all functions in the program.

Administrator as a fundamental user is registered in the administrator group. The administrator group has authority for all functions in the program. For the first time login, use initial administrator ID.

**Note** The number of users to be registered is unlimited.

4.3.1 User Group Registration

1. Select „System_->_User Manager_ menu. User & Group Manager setup window shows up.

2. Select User Group tab.

3. Click on „Add_ at the bottom of the group list.

4. Enter a group name and tick on desired functions from the group permission list.
5. Click on _Ok_ and selected functions are granted to the user group. The user group name will be shown at the user group list.

---

**Note**

- In order to register a user group, users must log in with one of ID from the administrator group. For the first time login, use the initial registered administrator.

---

### 4.3.2 User Registration

1. Select _System_->_ _User Manager_ menu. User & Group Manager setup window shows up.

2. Select User tab.

3. Click on _Add_ at the bottom of the group list.
4. Enter a user name and password and select a group from User Group. The user name and password are the basic requirement.

5. Click on „Ok_ and the user name will be shown at the user list.

Note ■ In order to register a user, users must login with one of ID from the administrator group. For the first time login, use initial administrator ID.
5. Menu

5.1 View

View menu is a collection of the panel window to be used in the program.

<table>
<thead>
<tr>
<th>No.</th>
<th>Menu</th>
<th>Icon</th>
<th>Function</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Site Connection List</td>
<td></td>
<td>Site Connection List Panel View</td>
<td></td>
</tr>
<tr>
<td>②</td>
<td>Event List</td>
<td></td>
<td>Event List Panel View</td>
<td></td>
</tr>
<tr>
<td>③</td>
<td>Site Status List</td>
<td></td>
<td>Site Status List Panel View</td>
<td></td>
</tr>
<tr>
<td>④</td>
<td>Basic Control Function</td>
<td></td>
<td>Basic Control Panel View</td>
<td></td>
</tr>
<tr>
<td>⑤</td>
<td>Pop up Image List</td>
<td></td>
<td>Pop up Image List Panel View</td>
<td></td>
</tr>
<tr>
<td>⑥</td>
<td>The Second Screen</td>
<td></td>
<td>The Second Screen Panel View</td>
<td></td>
</tr>
<tr>
<td>⑦</td>
<td>Network Player</td>
<td></td>
<td>Network Player Execution</td>
<td></td>
</tr>
<tr>
<td>⑧</td>
<td>File Player</td>
<td></td>
<td>File Player Execution</td>
<td></td>
</tr>
<tr>
<td>⑨</td>
<td>Device Setup Manager</td>
<td></td>
<td>Device Setup Manager Execution</td>
<td></td>
</tr>
<tr>
<td>⑩</td>
<td>Program Information</td>
<td></td>
<td>Program Information View</td>
<td></td>
</tr>
</tbody>
</table>
5.2 System

5.2.1 Log Manager

Log Manager is to manage an event log occurred in security devices and program function usage.

5.2.1.1 Log View

1. Select “System_->_Log Manager_ menu. Log Search Manager setup window shows up.

2. For the program usage log, select “Action_ tab. Dates saved with logs will be shown in the calendar. Select a desired date and log information will be shown. Searching by user, time and function are available.

3. For the event log in security devices, select “Event_ tab. Dates saved with logs will be
shown in the calendar. Select a desired date and log information of events and alarms will be shown. Searching by user, security device/PC time, site and event are available.

4. For the security device log, select „DVR Log“ tab. Dates saved with the log history will be shown in the calendar. Select a desired date and the log information of the security devices will be shown.

Note ■ The time used in „Action“ log is based on PC time. The time used in „Event“ and „DVR Log“ is based on the time of the security device.
5.2.2 App Setup

2. In „Storage_ tab, users can designate saving folders for the capture image file, record file and DVR setup file.

3. In „OSD_ tab, users can configure the name, height, thickness and color of the font to be displayed above the real-time monitoring screen. Also it sets up Enable/Disable of the time, resolution, title and other information to be displayed above the screen.

4. In „Border Line_ tab, users can configure the thickness and color of the border line that indicates the border line between channels in real-time monitoring.

5. In „Alarm Out_ tab, users can configure the alarm out, sound effect and duration in case events including „Power Off_ and „DVR Operation Fail_ occur from security devices.

6. In „Instant Live_ tab, users can enable/disable the event live popup and event popup image and setup the number of instant live viewers.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Off</td>
<td>An event that occurs when recording is stopped.</td>
</tr>
<tr>
<td>Record Continuous</td>
<td>An event that occurs during continuous recording</td>
</tr>
<tr>
<td>Record Motion</td>
<td>An event that occurs from motion detection</td>
</tr>
<tr>
<td>Record Sound</td>
<td>An event that occurs when it detects an audio sound from the mike</td>
</tr>
<tr>
<td>Record Sensor</td>
<td>An event that occurs from a sensor input</td>
</tr>
<tr>
<td>Signal Act</td>
<td>An event that occurs from a image input</td>
</tr>
<tr>
<td>Signal Loss</td>
<td>An event that occurs from a signal loss</td>
</tr>
<tr>
<td>Video Disconnect</td>
<td>An event that occurs when a camera is not connected</td>
</tr>
</tbody>
</table>
7. In „Display_ tab, users can change the pixel size and setup the video filter. Also a size, font and color of letters; „Connecting_, „Signal Loss_ and „Video Disconnect_ can be decided.

8. In „Playback_ tab, users can setup the vertical playback mode and last image display mode.

9. In „Language_ tab, users can select languages including English, Korean, Japanese, Polish, Hebrew, Portuguese, Spanish, Cantonese, Pekingese and Russian.

5.3 Setup

5.3.1 Edit Password

1. Select „Setup_->_Edit Password_ menu. Edit Password setup window shows up.

2. Users can change the password of current logged-in ID.

5.3.2 User Information

1. Select „Setup_->_User Information_ menu. User Information setup window shows up.

### Video Covert

An event that occurs when a camera is set to the covert function.
2. The name, group and group authority of the current logged-in user are displayed.

6. Viewer

6.1 Viewer Overview

The viewer is a multi-channel real-time program displaying a customized screen of multi-channel real-time monitoring images.

The viewer is a main function of the program and incorporates all program menus. It consists of various panels including Site Connection List, Screen Layout List, Event List, Basic Control Function and Status List Popup Image.

Users can check real-time events, status and connection information of the security device connected in Site Connection List, Event List and Status List. In Screen Layout List, users can customize channels and modes for real-time monitoring. In Popup Image, an image of the important event moment is captured and saved in an image format. In Basic Control Function, it provides PTZ, Relay, Two way Audio, Color Adjustment, Sequence and other functions.

6.2 Image View

In Viewer, there are three ways to have the real-time monitoring image. The first way is to drag a security device icon into the screen and all channels of the security device are displayed. The second way is to drag cameras from the security device list to desired locations of the screen and the selected camera will be displayed at the selected location. The third way is to collect cameras of the security devices in Screen Layout Function.

---

**Note**

- The channel mode automatically changes according to the number of added cameras when the user drag/drop icons.

- Images being displayed in the viewer move to other locations by dragging images.

- Images exchange each other if a image is dragged onto an occupied location.
6.2.1 Image View by connecting security devices
1. In Site Connection List, select a desired security device icon to be monitored.

2. Drag the icon into the viewer screen, and then all channel of the security device are displayed.

**Note**
- To disconnect the security device, right-click on a desired icon, and then select "Disconnect" in the popup menu.
- The channel mode automatically changes according to the number of channels.
- The max. number of channels to be displayed in the viewer are 64.

6.2.2 Image View by connecting cameras
1. In Site Connection List, double-click on a desired security device icon to be real-time monitored. Select camera icons from the camera list of the security device.

2. Setup a layout by selecting a channel mode in Channel Mode.

3. Drag camera icons onto the viewer screen, and then real-time monitoring images are displayed.

**Note**
- To disconnect the camera, drag a desire monitoring image out of the viewer screen.
- Users can setup the layout by 1, 4, 6, 8, 9, 10, 13, 16, 25, 36, 49, 64 channel mode.

6.2.3 Image View through the second monitor
1. In View menu, select the second screen or click on button in Tool Bar. The second monitor shows up.

2. Move the second screen to the second monitor.

3. Setup the layout by selecting a channel mode in Channel Mode.

4. Repeat 6.2.1 or 6.2.2 to bring images on the second screen.
6.3 Event List
6.3.1 Event Information View
1. In View menu, select an event list or click on button in Tool Bar. The event list window pops up.
2. Events occurred in connected security devices automatically are indicated in the event list. (No setup needed)

Note ■ The event list window is a docking window so that users can place the icon at a desired location and have a separate window.

6.4 Status List
6.4.1 Security Device Status Information View
1. In View menu, select a status list or click on button in Tool Bar. The status list shows up.
2. The status list shows status of the connected camera including PTZ Connection, Video Disconnect, Signal Loss and HDD status, and also indicates Two way Audio enable/disable, Relay enable/disable and HDD occupied/total capacity.

Note ■ The status list window is a docking window so that users can place the icon at a desired location and have a separate window.

6.5 Popup Image
Popup Image is a window showing a thumbnail real-time image transmitted from the security device when an event occurs. Setup in „App Setup„.
To bring thumbnail images in case of the event occurrence, tick on “Event Popup Image” in “Instant Live” tab at “App Setup”. (For more information, refer to 5.2.3 App Setup.)

6.5.1 Thumbnail Image View in Popup Image Window
1. In View menu, select a popup image or click on button in Tool Bar. The popup image window shows up.

2. The thumbnail image automatically shows if an event occurs from connected security devices. (Setup needed in App Setup)

6.6 Basic Control
Basic Control consists of PTZ control, Relay control, Two way Audio, Color adjustment, Screen sequence and other functions.

6.6.1 PTZ Control
PTZ Control is to control the PTZ camera with functions including Move, Zoom In/Out, Focus Adjustment, Preset, Speed Adjustment and Tour 1/2.
**PTZ Movement Control**
1. Select a PTZ camera to be moved.
2. Move the PTZ camera by pressing four direction keys.

**PTZ Focus Control**
1. Select a PTZ camera to be focus-controlled.
2. Press button to adjust the focus.

**PTZ Zoom Control**
1. Select a PTZ camera to be zoom-controlled.
2. Press button to zoom in/out.

**PTZ Preset Control**
1. Select a PTZ camera to be preset-controlled.
2. Select a preset number and press button. The camera moves to a preset position.
3. To designate a certain position as a preset position, move the camera to a desired position and select a preset number, and then press button. The position is saved as the preset position.

**PTZ Speed Control**
1. Select a PTZ camera to be speed-controlled.
2. Adjust the speed by moving the sliding bar. The speed of the PTZ camera gets faster or slower.

**PTZ Tour Control**
1. Select a PTZ camera to be tour-controlled.
2. Press button and the PTZ camera moves according to the tour no.1. Press button and the PTZ camera moves according to the tour no.2.
6.6.2 Relay Out Control

Relay Out Control is to setup the relay On/Off that is connected to the security device. The number of Relay Out varies depending on security devices.

1. Select a site to be relay out-controlled from the list.
2. Press \( \text{button} \) and request a relay out-control to the security device.
3. Status of the relay out is shown by \( \text{(Off)} \) (On) buttons.
4. The button is designed to be toggled. (On->Off, Off->On)

**Note** ■ The time out of the relay out is 5 seconds. After 5 seconds, the user has to request it again.

6.6.3 Two way Audio Control

Two way Audio Control is to send an audio sound from the program to a speaker of the security device.

1. Select a site to be two way audio-controlled from the list.
2. Press \( \text{button} \) and speak to a mike connected to PC.
3. A voice comes out of the speaker connected to the security device.

**Note** ■ The time out of the two way audio is 120 seconds. After 120 seconds, the user has to request it again.

6.6.4 Color Adjustment

Color Adjustment is to adjust color of the real-time monitoring image in the viewer screen.

1. Select a screen to be color-adjusted.
2. Adjust the value of Brightness, Gamma, Contrast, Saturation and Tint.
3. All channels can be adjusted with the same value by ticking on „All Channel“.
6.6.5 Screen Sequence Function

Screen Sequence Function is to rotate the layout of the real-time monitoring image in the viewer screen according to a desired time interval.

1. Select a channel mode. (1, 4, 9, 16 channel mode)

2. Select a rotation time interval. (2seconds ~ 60seconds)

3. Press button and it starts the rotation according to the set value.

6.6.6 Other Functions

Other functions include real-time monitoring screen capture, printing of the captured image, real-time image recording and full screen.

1. Press button and it saves the real-time monitoring screen as a file and brings the image editor "Picture Viewer_. This editor allows users to edit images by using the color adjustment and filter. (In 5.2.3 App Setup -> Storage tab, a saving folder is shown.)

2. Press button and it starts to record the real-time monitoring screen and audio together. The saved file can be played through "File Player_.

3. Press button and it changes to the full screen. Press "ESC_ key for return.

4. Press button. A captured image file list is shown and selecting one of them leads to the image in the reporting format document. Press the "Print_ button.
7. Network Player

7.1 Network Player Overview

Network Player allows users to search and playback recorded images and audios of the security device in multi-channel from distant PC.

Users can use a preview search to find recorded images and audios. Searching and thumbnail images by a second term are available. Users can download images and audios of the desired time period into PC.
7.1.1 Playback of the Recorded Image

1. Select icon in Tool Bar.
2. Setup searching conditions(Camera/Security device, Date/Time) in the searching panel of the player at left.
3. Designate a desired time to be played in “Go to_ and press button.

Note ■ The player can display recorded images of max. 16 cameras at the same time. (One security device)

7.2 Search

Users can search recorded images and audios in the security device by two means; the time search and preview search.

The time search is to designate a certain date/time and bring images appertaining to the designated date/time.

The preview search is to select a certain date and hour. A time line between 0minute 0second ~ 59minutes 59seconds shows up. Users can view thumbnail images by 1 second term.
7.2.1 Time Search

1. Select icon in Tool Bar.
2. Select a security device to be played from Connect List at the top-left.
3. Select a date and time to be searched.
4. Press button. Recorded images of the desired date/time are played on the top-right of the screen.
5. To re-setup the search condition, press default button.

Note ■ Users can select max. 16 cameras.

7.2.2 Preview Search

1. Select icon in Tool Bar.
2. Select a security device to be played from Connect List at the top-left.
3. Select a date and time to be searched and press button.
4. Setup a desired time to be searched at Go_to, bottom-left and press button. The time line of the preview search is shown.
5. As the time bar moves by one second term in the preview search, the preview thumbnail changes accordingly.
6. “To re-setup preview search conditions, press default button.

**Note** ■ Users can select max. 16 cameras.

### 7.3 Playback

#### 7.3.1 Playback Overview

After searching images and audios by two means, searched images and audios are played automatically if the user presses a playback button. The channel mode is automatically determined according to the number of cameras.

In the playback screen, the channel title, date/time and other information are displayed. Also, rectangular boxes with event colors are displayed at the bottom-left.

Multi-channels are played in the division mode. Double-clicking on a certain channel leads to the full screen. For return, double-click on the full screen.

In the time line, image information (recording event status) being played is indicated in color.

Users can move the bar and play at a desired location and also the snapshot and printing are available.
7.3.2 Time Line

Time Line indicates images and audios of the designated search condition and events by each channel in graphic lines.

The green line indicates that a recorded data exists. The red line means that an event recording data exists. The green space is that there is no data. Using a scroll at right, users can check the recorded event data from channel 1 to 16.

7.3.3 Playback Control

It indicates images and audios of the designated search condition and events by each channel in graphic lines.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>▲ ◀</td>
<td>Fast Reverse</td>
<td></td>
</tr>
<tr>
<td>◀</td>
<td>Reverse Play</td>
<td></td>
</tr>
<tr>
<td>◀ ◀</td>
<td>Reverse one frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pause</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Play one frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Play forward</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fast Forward</td>
<td></td>
</tr>
<tr>
<td>1X 1/3</td>
<td>Play Speed Adjustment</td>
<td>button for speed up, ▼ button for slow down.</td>
</tr>
<tr>
<td></td>
<td>Indication by events in the time line</td>
<td></td>
</tr>
</tbody>
</table>

Caution

Some of the security devices may not be supported with all functions.

7.3.4 Control

In Player, users can use a channel mode change, full screen, zoom function, capture and print function.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Playback in 1, 4, 9, 16 channel mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Full Screen</td>
<td></td>
</tr>
</tbody>
</table>
7.4 Download

In Download, users can download and save recorded images and audios from the security device to PC.

7.4.1 Download of the Recorded Data

1. Select icon in Tool Bar.
2. Select a security device to be played from "Connect List_ at the top-left.
3. Press button and the download window pops up.
4. In the download window, setup a start date/time and end date/time, and then tick on desired channels and designate a saving route.
5. Press "Start_ button to initiate downloading.

Note
- The download data is saved as a folder and the folder name is "start date/time_end date/time".
8. File Player

8.1 File Player Overview

File Player is to search and play a downloaded image/audio file in the PC in multi-channel screen.

Smart Search enables users to search in the thumbnail image list of the motion detection.

8.1.1 Playback of the Recorded Data

1. Select icon in Tool Bar.

2. In Tool Bar, select a data folder by pressing or button. (In File menu, users can select "Folder Open" or "File Open").

3. It starts playing recorded data files.

8.1.2 Time Line

Time Line indicates images and audios of the designated search condition and events by each channel in graphic lines.

The green line indicates that a recorded data exists. The red line means that an event recording
data exists. The green space is that there is no data. Using a scroll at right, users can check the data of the recorded events from channel 1 to 16.

### 8.1.3 Playback Control

It indicates images and audios of the designated search condition and events by each channel in graphic lines.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Fast Reverse</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reverse Play</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reverse one frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pause</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Play one frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Play forward</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fast Forward</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Play Speed Adjustment</td>
<td>▲ button for speed up, ▼ button for slow down.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Indication by events in the time line</td>
</tr>
</tbody>
</table>

### Caution

- Some of the security devices may not be supported with all functions.

### 8.1.4 Control

In Player, users can use a channel mode change, full screen, zoom function, capture and print function.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Playback in 1, 4, 9, 16 channel mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Full Screen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Image Enlargement (100%, 150%, 200%, 300%, 500%, 700%, 1000%, 1600%)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Screen Capture</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Screen Print</td>
<td></td>
</tr>
</tbody>
</table>

### 8.2 Smart Search

Smart Search is to search a motion in the specific area of the recorded image data. searched images are saved as thumbnail images in time sequence.
8.2.1 Smart Search

1. Select button in Tool Bar. (Select Smart Search in Tool menu)

2. Setup a desired area to be motion-searched.

3. Select a desired channel to be smart-searched, start date/time and end date/time.

4. In Time Interval, select All Images or Time Interval(sec).

5. Press Search button and it starts smart-searching.

6. Select searched thumbnail images and press Playback. It starts the playback from the selected time period.
9. Security Device Setup Administrator

9.1 Security Device Setup Administrator Overview

Security Device Setup Administrator is to setup security devices from a remote PC directly. The administrator can save a setup value and apply it to other security devices to make the same configuration. The administrator can open and edit a setup value file.

9.2 Start of the Security Device Setup

1. Select button in Tool Bar.

2. Users can change a setup value of the security device by using Security Device Setup Administrator.

3. After changing setup values, press “Send” button and the changed setup value applies to the security device.

9.3 Open/Save Setup Value

1. Go to “Open” in “File” menu and select a file.

2. After changing setup values, select “Save” or “Save as” in “File” menu and save the setup value.

3. Press “Send” button and changed setup values apply to the security device.

9.4 Setup Data Reset and Factory Default Reset

1. Press “Setup Data Reset” in “File” menu, all changed values reset to the initial setup value.

2. Press “DVR All Reset” in “File” menu, all values reset to the factory default value.

3. After changing setup values, press “Send” button and changed setup values apply to the security device.
Caution • Please be aware that "DVR All Reset" function resets a security device to the factory default value including the network address so that users can't access to the security device.